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As you read this text you will find a number of features in every
chapter to enhance your study of SPSS Statistics and help you
understand how the theory is applied in the real world.

FEATURES WITHIN CHAPTERS

Step-by-step instructions and annotated
screenshots clearly and visually explain each
procedure to help students easily understand
how to use SPSS Statistics version 28.
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Return to the Analyze menu,
select General Linear Model,
then Univariate.
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Dmenticn Redicten

Scale

Dota View  Vanatie View

Henparamatric Tests
Unmanate 1EM SPSS Statist

Comptex Samples

Checklists at the end of each analysis chapter
remind you of key concerns and the steps to
complete.

A Decision tree printed inside the front cover
quickly guides you to appropriate procedures for
your circumstances.

Do you want to ...
{a). Compare Samples?
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4.5. One Sample t Test Checklist

Have you:

v Checked that your data are approximately normally distributed?

v Interpreted the results of the ¢ test and taken note of the t value, degrees of freedom,
significance, mean difference and confidence interval for your write-up?

v Calculated a measure of effect size, such as Cohen’s d?

v Reported your results in the APA style?

The AKA icons indicate
where key terms could

Ask your instructor
for the data and

Follow the LINK icons to
revisit useful topics from

Use the Tip icons for
handy hints to complete

syntax sets used in the be described differently the step. other chapters as you go
examples. Look out for in other resources. along
the Try it out icons and
follow the step-by-step
guide exactly.
P Link:

D Try It Out:
This is data file
data_4_1.sav.

9 pka:

Single sample t test.

® rip:
Report the absolute

value of d, rather than
a negative value.

Setting up a data
file is illustrated in
greater detail in
section 1.2.
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Guide to the online resources

FOR THE INSTRUCTOR

au.cengage.com/instructor/account
nz.cengage.com/instructor/account

DATASETS AND SYNTAX SETS

All the datasets and syntax sets used in the examples.

INSTRUCTOR'S MANUAL

The Instructor’s manual includes:

e Author’s guide to the resources

e Practice exercises with solutions

e Practice exercise worksheets and matching datasets
e Revision quizzes

POWERPOINT™ PRESENTATIONS

Use the chapter-by-chapter PowerPoint slides to enhance your lecture presentations and handouts by
reinforcing the key principles of your subject.

ARTWORK FROM THE TEXT

Add the digital screenshots into your course management system, use them in student handouts, or copy
them into your lecture presentations.




Preface xvii

PREFACE

IBM SPSS Statistics is a flexible set of data analytic tools used throughout many disciplines. Its roots can be
traced back as far as 1968, when a small group of Stanford University doctoral students began developing the
Statistical Package for the Social Sciences in response to their own need for a software system that would allow
them to efficiently analyse the large amounts of data they were amassing at that time.

This program quickly grew beyond the cloistered confines of Stanford, with the publication of the first user
manual in 1970. SPSS Statistics: A Practical Guide continues this long tradition of opening statistical analysis up
to students and early career researchers from a wide range of applied and academic disciplines. We hope you
find it useful!

About IBM SPSS Statistics Version 28

IBM released IBM SPSS Statistics Version 28 in late 2021. SPSS Statistics is available for a number of operating
systems, including Microsoft Windows, Macintosh OSX, and several Linux distributions.

For more information about SPSS Statistics, visit https://www.ibm.com/au-en/analytics/spss-statistics-
software.

About this book

With SPSS Statistics: A Practical Guide we aim to introduce readers to a range of commonly used statistical
procedures that can be performed with SPSS Statistics, and are typically included in the curricula of
undergraduate applied statistics and research methodology units.

Our approach is unashamedly practical, and highly visual. We take a hands-on approach to our subject
matter, and work through each procedure in an illustrated, step-by-step fashion. Beyond the necessary focus
on “doing”, we emphasise interpretation and reporting throughout this text, which contains hundreds of tables
of tightly annotated SPSS Statistics output, and dozens of examples of how specific research findings can be
communicated clearly and concisely.

Other prominent features of this text include:

Mustrated examples of statistically “significant” and “non-significant” findings, recognising that real-
life data does not always support our hypotheses.

Guidelines for calculating and interpreting effect sizes for most of the inferential procedures discussed
in this book.

+  Power calculations and Baysian analyses are discussed.

An ongoing emphasis on assumption testing, with recommendations for dealing with violated
assumptions.

+ An extensive section on non-parametric procedures.

Online resources including datasets and syntax files, which are available at http://login.cengagebrain.
com.au.

The screen captures used throughout the book were taken with SPSS Statistics version 28 for Windows. If
you're using an older (or newer) version of SPSS Statistics, or SPSS Statistics for Macintosh OSX or Linux, you
may notice small differences between our captures and the windows and dialogue boxes on your own screen. In
virtually all instances, these differences will be slight, and should not hinder your ability to follow our worked
examples. However, if you do notice any substantial differences between your version of SPSS Statistics and
ours, please let us know, and we’ll be sure to make a note of it in the next edition of this text.

We do not anticipate that you will read this text from cover to cover. Rather, we hope you'll be able to pick
it up and identify quickly the sections you need to ‘get the job done’. To make this task easier, we've divided our
content into 18 conceptually distinct chapters.
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Chapters 1 to 3 introduce new users to the SPSS Statistics interface, and to some of the many ways SPSS
Statistics can be used to manipulate, summarise and display data. Chapters 4 to 17 are dedicated to specific
inferential procedures, including:

+ ttests (one sample; independent samples; and paired samples).

+ Analysis of variance (one-way and factorial; between groups, repeated measures and mixed).

+Analysis of covariance.

+ Multivariate analysis of variance.

+  Bivariate and partial correlation.

+ Multiple regression (both standard and hierarchical).

+  Logistic regression (focusing on binary logistic regression).

+  Factor analysis.

+  Reliability analysis.

+ Non-parametric alternatives (including chi-square tests for goodness of fit and contingencies;
Mann-Whitney’s U; McNemar’s test of change; Wilcoxon’s signed rank test; the Kruskal-Wallis
ANOVA,; the Friedman ANOVA; Cramer’s V; Spearman’s rho; and Kendall’s tau-b).

Within each of these chapters, we outline the purpose of the test(s), and illustrate the types of research
questions they can be used to address. We then step the reader through one or more illustrated examples,
from initial assumption testing through to follow-up analyses and effect-size estimation. Each example then
concludes with an annotated APA (American Psychological Association) style results section, demonstrating
exactly how research findings can be clearly communicated in reports, assignments and poster presentations.
All the examples and research findings discussed in this text are for illustrative purposes only. The datasets have
been created by the authors and are not based on actual research studies.

Finally, Chapter 18 looks at the use of SPSS Statistics command syntax, and the flexibility and efficiencies
it can offer more advanced users.

Some final comments

This is not a statistics textbook, and we are not mathematicians. We use statistics as a means to an end; as a tool
for managing and making sense of the data we collect as part of our efforts — through our research — to better
understand the world around us. We're assuming that most of our readers feel the same way, and are using SPSS
Statistics to take some of the time-intensive number-crunching out of data analysis (thus freeing us all up to do
more important things, like interpreting our findings and communicating them to our colleagues and beyond).

Having said that, we do assume that you have a basic understanding of applied statistics, as well as issues of
research design more broadly. If not (or if you're just feeling a bit rusty), we recommend using our text alongside
books that do justice to these important issues.

There are many such books available. For introductory level statistics, we recommend Gravetter, Wallnau &
Forzano’s (2018) Essentials of Statistics for the Behavioral Sciences and Howell's (2017) Fundamental Statistics
for the Behavioral Sciences.

Happy analysing!

Kellie Bennett
Division of Psychiatry, Medical School University of Western Australia

Brody Heritage
Discipline of Psychology, Murdoch University
Telethon Kids Institute, University of Western Australia

Peter Allen
School of Experimental Psychology University of Bristol
February 2022
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Chapter 1: Getting Started With SPSS Statistics

Chapter Overview
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1.2. Creating a Data File
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1.1. Introduction

This chapter has two purposes: (a) to introduce the SPSS Statistics Data
Editor; and (b) to step you through the process of setting up a simple SPSS
Statistics data file.

1.1.1. Data View

The drop-down menus provide access
to the full range of options and
analyses available in SPSS Statistics.

These shortcut buttons provide quick access to a number of
commonly performed operations (such as Open, Save, Print and
Find). Hover your mouse cursor over each for further information.

L)

File Edit View Data Transform Analyze Graphs Utilities Extensions Window Help

\:I-J g 2z ﬁ ﬁ{.{ % j ‘1% ‘:‘Ii;' E C)\

Visible: 0 of 0 Variables
var var var var var var var var var var

10 Toggle between the Data View and the

11 Variable View with these tabs.

12

13 We are currently in the Data View.

14

15 v
< >

Data View Variable View

IBM SPSS Statistics Processor is ready 4! Unicode:ON Classic

>>| Link:

The Data Editor is
just one component
of the SPSS Statistics
working environment.
Other components
discussed in this book
include:

« Viewer is used in
chapter 3 (section
3.2.1.3)

Pivot Table Editor
is used in chapter 3
(section 3.2.1.3)
Chart Editor is used
in chapter 3 (section
3.4.1.3)

Syntax Editor is
used in chapter 18
(section 18.2.2)
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(D Tip:

Work in rows in the
Variable View, where
each row defines one
variable in your SPSS
Statistics data file.

(D Tip:

Interval and ratio data
(which are both
referred to as Scale
data in SPSS
Statistics) have the
properties we tend to
associate with “real
numbers”.

Ordinal data can be
ranked (i.e., an
ordinal scale has
magnitude), but they
lack any other
numeric properties.

Nominal data are
categorical, and the
values we assign to
levels of a nominal
variable are nothing
more than shorthand
labels. They have no
true numeric
properties.

1.1.2. Variable View

| Eile Edit View Data
| B
=
Name Type
1
3
4
B
8
9
10
11
12
13
14

o

16

<

Data View = Variable View

Transform  Analyze  Graphs  Utilities Extensions Window Help

BL=E A EE ¢

Width Decimals Label Values Missing Columns Align Measure

In the Variable View, the characteristics of each variable in the data file are
defined. These characteristics are:

Name. The variable name that will appear at the top of each column in the Data
View. It cannot contain spaces or any special characters, and cannot start with a
number.

Type. SPSS Statistics can handle several types of data. In most circumstances,
the default - Numeric - should be selected.

Width. The default width is “8”, and will be fine in most instances.
Decimals. Specifies the number of decimal points displayed in the Data View.

Label. Used to add a more detailed description of the variable, not subject to the
limitations imposed on variable Names.

Values. Used to define Value Labels for the codes used to represent levels of
categorical variables.

Missing. Used to specify the numeric codes that represent missing data.

Columns. The number of characters/numbers displayed in each column in the
Data View.

Align. Used to specify whether the variable is Left, Right or Center aligned in
the Data View.

Measure. Used to specify whether the variable is Scale, Ordinal or Nominal.
SPSS Statistics does not discriminate between interval and ratio data. It refers to
them both as Scale data.

Role. Used to set predefined roles for variables, so they can be automatically
sorted into appropriate lists in selected SPSS Statistics dialogues. As many
dialogues do not yet support roles, the default option (Input) will usually be fine.
See the Tip in Section 1.2 for more information.
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1.2. Creating a Data File

To illustrate the process of creating and setting up a data file, we developed a
simple survey, and asked 15 students in the Health Sciences café to complete
it. We've reproduced four of the completed surveys in full, and the data that
were collected with the remaining 11 are summarised in Table 1.1.

Participant 1

Participant 2

A Quick Student Satisfaction Survey!

1. Gender: Male |ﬂ Female [] (Please tick)

2. Age: '7

3. Course of Study: ngeeCA 1‘/7'3’4‘95/

On a scale from 1 (strongly disagree) to 5 (strongly
agree), please indicate the extent to which you agree
with each of the following statements:

4. 1 am enjoying my course.

sb 1 2 3 4@ SA

5. It is easy to get good grades in my course.

sb 1 2 3 4(2 SA

Thanks for completing our survey!

A Quick Student Satisfaction Survey!

1. Gender: Male ﬁ Female [] (Please tick)

2. Age:

3. Course of Study: Pl’lMS’LD‘tI’lCYﬂ‘Plx]

On a scale from 1 (strongly disagree) to 5 (strongly
agree), please indicate the extent to which you agree
with each of the following statements:

4. I am enjoying my course.

sb 1 2 3 @ 5 SA

5. It is easy to get good grades in my course.

sb 1 2 @4 5 SA

Thanks for completing our survey!

Participant 3

Participant 4

A Quick Student Satisfaction Survey!

1. Gender: Male [] Female Z/ (Please tick)

2. Age: IS

o7

3. Course of Study:

On a scale from 1 (strongly disagree) to 5 (strongly
agree), please indicate the extent to which you agree
with each of the following statements:

4. I am enjoying my course.

sb 1 2 3 4 QSA

5. It is easy to get good grades in my course.

sb 1 2 3 @5 SA

Thanks for completing our survey!

A Quick Student Satisfaction Survey!

1. Gender: Male 5 Female [] (Please tick)

2. Age: 17

PHYSIO.

3. Course of Study:

On a scale from 1 (strongly disagree) to 5 (strongly
agree), please indicate the extent to which you agree
with each of the following statements:

4. I am enjoying my course.

SD123055A

5. It is easy to get good grades in my course.

sb 1 2 3 5 SA

Thanks for completing our survey!

D Try It Out:
This is data file
data_1_1.sav.
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Table 1.1

Data Collected From Participants 5-15 With "A Quick Student
Satisfaction Survey”

ID Q1 Q2 Q3

o
s
re)
%]

5 Female 20 Physiotherapy 4 4
6 Female 21 Psychology 3 3
7 Female 19 Speech Therapy 3 2
8 Male 18 Speech Therapy 2 1
9 Male 19 Nursing 3 3
10 Female 21 Public Health 5 4
11 Female 24 Occupational Therapy 4 3
12 Female 17 Occupational Therapy 1 1
13 Female 38 Nursing 3 3
14 Male 19 Occupational Therapy 4 5
15 Female 18 Occupational Therapy 5 4
Begin in the Variable View by defining Click on a Measure cell, Click on a Role cell to
each variable. We will need six rows: and select the select from the six
one for each of our five questions, plus appropriate & Scale v available roles.
(D Tip: a sixth — ID - to help us keep track of measurement & scale
Some dialogues in our participants. scale from the ol ordinal The default variable
SPSS Statistics 28 drop-down Y . Role is Input. In most
. _ " @> Nominal h N
support Roles. Work in rows, defining one variable at a menu. instances this does not
| time. need to be changed.
When you use one of
these dialogues, your
variables will be e
automatically sorted @
into lists according to File Edit View Data Iransform Analyze Graphs Utilities Extensions Window Help
their defined roles. - — _
= 4 @ =20 09 Q
There are six possible L"_"'J G = ﬁ o B ~/
roles to select from: Name Type Width  Decimals Label Values Missing  Columns Align Measure Role
1 ID Numeric 3 0 ParticipantlD  None None 3 @5 Nominal N Input
Input. Should be 2 | Gender Numeric 8 0 Gender o, Male}.. 9 8 & Nominal N Input
selected for predictor 3 Age Numeric 8 0 Age None 9 8 & Scale . Input
or independent ) o) -
variables. 4  Course MNumeric 8 0 Course of Study {1, Psycholg 9 8 @5 Nominal N Input
5 Enjoy Numeric 8 0 | am enjoying ... MNone 9 8 & scale N Input
Target. Should be 6 | Easy Numeric 8 0 Itis easytoget.. None 9 8 & Scale N Input
selected for output or 7
dependent variables.
Both. Should be ?
selected for variables il
that will be used as "
both predictor and 12 All our data are Numeric. We The Values (or codes) that we use to
output variables. 13 will use numbers to represent represent the levels of each categorical
14 the different categories of variable are defined here. They are
None. Should be 15 gender and course of study. discussed in greater detail overleaf.
selected for variables =
that you do not want 25
to assign a specific T

role to. ]
Data View = Variable View

Partition. Used to

partition the data file IBM SPSS Statistics Processor is ready 9 Unicode:ON Classic

into separate samples.

Split. Included for

compatibility with

SPSS Modeler. Labels can be used to provide more detailed Sometimes, research participants miss or elect not to
descriptions of variables than are permitted in answer certain questions (as was the case with our

As most SPSS the Name field. If you provide a variable Label, second participant, who did not provide their age). At

Statistics dialogues it will be used throughout your SPSS Statistics other times, recording equipment may fail, or render

currently ignore output. some of your data unintelligible. In circumstances like

variable Roles, you these, we can use Missing values codes, which are

can too! described in more detail overleaf.
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Value Labels

()
In SPSS Statistics, we often use numeric n
Values (or codes) to represent levels of
categorical (or Nominal) variables, like
gender or course of study.

Value Labels:
We define these codes in the Value
Labels dialogue. Value »

1

To open the Value Labels dialogue, 2
select a Values cell in the Variable
View, then click D. j
Type the number used to represent the 5
first category (or level) in the Value box, 6
and the category name in the Label box. 7

Click the Add button to add them to the
Value Labels list.

Label

Psychology

Speech Therapy
Physiotherapy
Occupational Therapy
Nursing

Public Health
Biomedical Sciences

Repeat this process for the remaining | oK

|| Reset ||Cance||| Help |

categories, then click OK to close the

Value Labels dialogue.

Here, we have used the values “1” through “7” to represent the seven courses that our student participants are enrolled in.

Missing Values

It is inevitable that, from time to time, you will be confronted with
missing data. Participants sometimes miss questions, recording
equipment fails, coffee spills smudge answers, and so on. We can
record unfortunate situations like these with Missing Values codes.

At the simplest level, we can use one numeric code to represent all

B

O No missing values

@® Discrete missing values

sw ][

types of missing data. Or, we can discriminate between different sorts
of missing data (e.g., questions that participants refused to answer,
versus questions which were missed due to equipment failure) by
specifying up to three unique Missing Values codes.

(O Range plus one optional discrete missing value

You can use any numeric code(s) to represent missing data, provided
they are outside the range of your actual data. You can also use
different codes on each variable, or the same code(s) throughout the
entire data file.

We've selected “9” as our Missing Values code because it can’t be confused with “real” data on any of our research
variables. (For example, none of our participants will have a gender of “9”, or will have responded with “9” to any of our 5-
point rating scales.)

The Missing Values dialogue is accessed by selecting a cell under Missing in the Variable View, then clicking the B
button. Missing Values codes must be specified separately for each variable.

After defining each variable, you can begin typing in data. In the Data View, each row represents a
case (e.g., a participant). For example, row 3 contains the data provided by participant 3, an 18-year-
old Occupational Therapy student.

Fi Edit View Data Transform Analyze Graphs Utilities Extensions Window Help
A b EA & iz L = Al (T
= g | fF M= 49 E ()\
|Visible: 6 of 6 Variables
&0 @5 Gender ¢ Age & Course ¢ Enjoy ¢ Easy var var ar var var

1 1 1 17 2 5 5 ~
2 2 1 9 3 4 3
3 3 2 18 4 5 4
4 4 1 17 3 4 4
5 5 2 20 3 4 4
6 6 2 21 1 3 3
v Participant 2 did not 2 3 Use the value codes specified in Value Labels to indicate which course
8 provide his age, so our 2 2 (and gender) category each participant belongs to.
9| Missing Values code, "9”, 5 3
1 has been entered instead. 6 5 You can toggle between displaying values or value labels by clicking
1 4 4 the Value Labels X
button on the shortcut toolbar: ;3
12 12 2 17 4 1
13 13 2 38 5 3
14 14 1 19 4 4 When value labels & Age & Course ¢ Enjoy & Easy
. 15 2 18 4 5 3;‘2:;32'%?:83’5“ 17 |Speech The... 5 5
something like this: 9 Physiothera... 3
Data View Variable View 18 Occupation... = 4
IBM SPSS S

(D Tip:

If you ever need to
discriminate between
more than three types
of missing data, you
can select Range
plus one optional
discrete missing
value and enter a
range of values you
want SPSS Statistics
to treat as “missing”.
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1.3. Conclusion

@ *data_1_1.sav [DataSet1] - IBM SPSS Statistics Data Editor - a X

File Edit View Data Transform Analyze Graphs Utilities Extensions Window Help

- =B A BE LA

Open >
\Visible: 6 of 6 Variables

injoy & Easy var var var var \

Import Data >
General Open
(£ Open Restore Point...
i)
£ Save Ctri+S
Save As...
) Save All Data
D Save Restore Point...

Export >
“® Mark File Read Only Either select Save (or Save As) in the File menu,

i or click the H icon on the shortcut toolbar.
Revert to Saved File &

B4  File Enabled for Auto-Recovery e
Collect Variable Information

LR RS

3
2

- N W s s WO,

Don't forget to Save your data file regularly.

i Rename Dataset... Statistics Processor is ready Unicode:ON Classic
Display Data File Information >

EA Cache Data...

@ Stop Processo trl+Pe

4 Print Preview

& Print... Ctrl+P

Welcome Dialog...

Recently Used Data >
Recently Used Files >
Manage License

Sign Out and Exit

Exit

With the data saved, we can begin working with it, summarising it and
displaying it. These are the topics covered in chapters 2 and 3.

Copyright 2023 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. WCN 02-300



Chapter 2: Working With Data

Chapter Overview

0 R 1 0o o T 1 o e o 7
0 o 2 Y0 11 = 8
2.2.1. Illustrated Example of Summed Scale SCOresS ......covviviiiiiiiiiiiiii e 8
G TR (=T o o = 9
2.3.1. Illustrated Example of Category ReCOdiNg .......cuvvvuiiiiiiiiiiiiiiiiiiinni e 10
2.4, MiSSING Value AN@IYSIS cuuuuiuiiiiitiii 12
2.4.1. Illustrated Example of Missing Age Data Replacement ...........coovviiiiiiiiiiinnnnnens 12
2., S I Rl caiitie i e 14
2.5.1. Illustrated Example of Splitting Output by Gender...........cccooviiiiiiiii 14
S T ST = ot 00 T = 17
2.6.1. Illustrated Example of Selecting Cases Above a Specified Age .......cocvviiiiiiiiiininnns 17
0 A 1o Lol [ 11 o o 18

2.1. Introduction

In chapter 1 we described a short survey used to collect some demographic
and course satisfaction data from 15 Health Sciences students. In the current
chapter, we will continue using this data to illustrate how a data file can be
manipulated in SPSS Statistics.

The data we collected are reproduced in Table 2.1.

Table 2.1
Data Collected From 15 Participants With “"A Quick Student Satisfaction O 1ry 1t out:
Survey” 'dl'his is data file
ata_2_1.sav.
ID Q1° Q2 Q3° Q4 Q5
1 Male 17 Speech Therapy 5 5
2 Male Physiotherapy 4 3
3 Female 18 Occupational Therapy 5 4
4 Male 17 Physiotherapy 4 4
5 Female 20 Physiotherapy 4 4
6 Female 21 Psychology 3 3
7 Female 19 Speech Therapy 3 2
8 Male 18 Speech Therapy 2 1
9 Male 19 Nursing 3 3
10 Female 21 Public Health 5 4
11 Female 24 Occupational Therapy 4 3
12 Female 17 Occupational Therapy 1 1
13 Female 38 Nursing 3 3
14 Male 19 Occupational Therapy 4 5
15 Female 18 Occupational Therapy 5 4

Note. Q1 = Gender; Q2 = Age; Q3 = Course of study; Q4 = I am enjoying my course (from 1 = strongly disagree to 5 = strongly
agree); Q5 = It is easy to get good marks in my course (from 1 = strongly disagree to 5 = strongly agree).

2Value labels for gender are 1 = male; 2 = female.

b value labels for course of study are 1 = Psychology; 2 = Speech Therapy; 3 = Physiotherapy; 4 = Occupational Therapy;
5 = Nursing; 6 = Public Health; 7 = Biomedical Sciences.
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D Try It Out:
Run these analyses
with
syntax_2_1.sps.

>>| Link:

Compute Variable
is used in chapter 6
(section 6.3.2.2) to
create a difference
scores variable.

(D Tip:

SPSS Statistics
includes many
functions that can be
used to compute new
variables.

To access these
functions, select a
Function group and
then choose from the
options available in
the Functions and
Special Variables
list.

When a selection is
made, the function’s
description is provided
in the space to the
right of the variable
list.

If the selected
function meets your
requirements, it can
be moved into the
Numeric Expression
box with the

arrow button:

2.2. Compute

Compute Variable allows you to create a new variable from one or more
existing variables. You can also use it to alter an existing variable.

2.2.1. lllustrated Example of Summed Scale Scores

Most commonly, we use Compute Variable to sum or average participants’
responses to questionnaire items. Here, we'll create a new variable - course

satisfaction — by averaging our participants’ answers to Q4 and Q5.

Eile

Edit Data

H&E 0

View

& 1D d

WO N ;A WN -
©W O N ;AW N

==
N oo
-
oS

<

Data View Variable View

Compute Variable

1\;& *data_2_1.sav [DataSet1] - IBM SPSS Statistics Data Editor

Transform  Analyze Graphs  Utilities Extensions Window Help
& Compute Variable. .. P =B A
- I = e

[ Count Values within Cases
Shift Values

m Recode into Same Variables

ol Q

Visible: 6 of 6 Variables

m] X

-

In the Transform menu,
select Compute Variable.

{8 Date and Time Wizard
[ Create Time Series

5 5

Recode into Different Variables E 3
[ Automatic Recode 5 4 1

k) 4

{2 Visual Binning 1 .

[ Optimal Binning 3 3

Prepare Data for Modeling > 3 2

B4 Rank Cases 2 1

3 3

5 4

1 3

1 1

@[ Replace Missing Values
@ Random Number Generators
IS)

IBM SPSS Statistics Processor is ready <

Unicode:ON Classic

Give the new
variable a Name
in the Target
Variable box.

In the Type &
Label dialogue,
enter a more
informative Label
for the new
variable (e.g.,
course
satisfaction).

4
: : Build the

Numeric
Expression that
will be used to
calculate values
on the new
variable. Here:

(Enjoy + Easy) / 2

(Enjoy and Easy
are the Names of
the variables
being averaged.)

Type directly into
the Numeric
Expression box,
or build the
expression using
the keypad, arrow
button and
variable list.

) Compute Variable

Target Variable: Numeric Expression:
—T®satisfaction = |(Enjoy + Easy)2
ype & Label
& Participant ID [ID] &
&> Gender [Gender] Function group:
& Age [Age] All ~
& Courserf Study [ Avithmetic
& | am enjoying my ... CDF & Noncentral CDF
& ltis easy to get go... Conversion

(]
(/]

(optional case selection condition)

/ Weset ||Cancel” Help ‘

Current Date/Time
Date Arithmetic
Date Creation

FEunctions and Special Variables:

v

Clicking the If button opens the If Cases
dialogue, in which you can specify which cases the
Numeric Expression should be applied to.

For example, the conditional statement “Gender =
1" would apply the “(Enjoy + Easy) / 2" expression
to the male cases only.

For our purposes though, we will calculate a
satisfaction score for every case in our data file.

Click OK to
create the new
variable.
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"\.}J *data_2_1.sav [DataSet1] - IBM SPSS Statistics Data Editor
File

Edit View Data Transform Analyze Graphs

Utilities

Extensions

Window

Help

g J—l 3 H EEEd i B === A ( - §
== . = = B oassi e 2 El Q
L} g m 1T o
The new course satisfaction variable has —_—— s
been created. We can check its accuracy Visible: 7 of 7 Variables
with a couple of quick calculations. 6¢> Enjoy 6? =5 6§> S —
1 5 5 5.00 ~
2 Using participant 2 as an example, if: 4 3 3.50
= Satisfaction = (Enjoy + Easy) / 2 5 4 4.50
4 4 4 4.00
5 Then: 4 4 4.00
6 Satisfaction = (4 + 3) / 2 3 3 3.00
7 3 2 250
8 =35 2 1 150
9 3 3 3.00
10 10 2 21 5 4 450
11 1" 2 24 4 3 3.50
12 12 2 17 4 1 1 1.00 o

< >

Data View Variable View

IBM SPSS Statistics Processor is ready Unicode:ON Classic

2.3. Recode

With Recode you can change specific values or ranges of values on one or
more variables. This feature can be used to:

a. Collapse continuous variables into categories.

We could collapse the satisfaction variable into two categories (“not
satisfied” or “satisfied”) by recoding scores of 3 or less as “1” (where 1 =
not satisfied) and scores higher than 3 as “"2” (where 2 = satisfied).

b. Combine or merge values.

We could merge the courses into two categories - those that require new
enrollees to have studied high-school human biology, and those that
don't.

C. Reverse negatively scaled questionnaire items.

Oftentimes, questionnaires contain both positively and negatively worded
items. For example:

1. I am enjoying my course. Strongly Disagree 1 2 3 4 5 Strongly Agree

2. I hate my course. Strongly Disagree 1 2 3 4 5 Strongly Agree

On this questionnaire, a participant who answers “5” to the first question

would likely answer “1” to the second question, and summing or averaging

these responses would make very little sense. However, by reversing his

or her response to the second question (by recoding 1 as 5, 2 as 4, and so
on) we are able to calculate a meaningful total or average, which can then

be used in subsequent analyses.
d. Replace missing values.

e. Bring outliers and extreme scores closer to the rest of the distribution.

>>| Link:

Recode is used to
reverse negatively
scaled questionnaire
items in chapter 16
(section 16.2.1.2).





